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Cisco UC Integration for IBM Sametime
• Introduction, page v
• Documentation Resources, page v

Introduction
Cisco Unified Communications Integration for IBM Sametime enhances productivity by integrating native
audio and HD video capabilities for IBM Sametime. It also includes Cisco phone control and presence status,
along with integrated voicemail and conversation history. The integration allows access to Cisco call control
with IBM Sametime IM and presence for both the standalone and IBM Lotus Notes-embedded clients.
The integration provides Sametime users with the following Cisco UC capabilities:
• Ability to use their computers for audio and video calls
• Ability to use Cisco UC Integration for IBM Sametime to control their phones
• Phone presence over XMPP
• Click-to-call capability from the IBM Sametime client
• Integrated visual voicemail and conversation history
• Users can easily create and manage audio and video conferences

Documentation Resources
Provide your users with the following documentation resources:
• For the latest information about issues, caveats, and product compatibility, see the Release Notes for
Cisco UC Integration for IBM Lotus Sametime.
• For information about how to install and use the integration, see the Quick Start Guide for Cisco UC
Integration for IBM Sametime.
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Search Tips

Search Tips
We recommend that you use the external Google Search (http://www.google.com) to find additional information.
Use the following formula in the search field:
<product name> <release number> <topic keywords> site:cisco.com
• meetingplace 7.0 recording disk space site:cisco.com
• mobility advantage 7.0 compatibility matrix site:cisco.com
• presence 7.0 disaster recovery site:cisco.com
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Integration Deployment
• Integration Deployment Methods, page 1
• Deploy the Integration, page 1
• User preparation for integration setup and use, page 2

Integration Deployment Methods
The primary method to deploy the integration is to use a widget to deploy its features to an existing IBM
Lotus Notes client. The widget uses a combination of the widgets catalog, an NSF-based update site in which
the feature resides, an XML file attached to the widget that calls the feature update site, and Domino policy
or Eclipse preferences.
Alternatively, users can manually install the integration on their workstations. With this method, you must
provide users with the URL of the update site.

Deploy the Integration
Before You Begin
Before you deploy Cisco UC Integration for IBM Sametime, an administrator must consider factors such as:
• Whether to enable or disable voicemail
• Whether to enable or disable the phone status feature
• Whether to enable or disable the use my phone for calls phone mode
• Whether to enable or disable the use my computer for calls phone mode
• Which phone mode to set as the default for users
• Whether video should start automatically for all users. Each user can choose, individually, to disable
the feature, but concurrent widespread use might drain network resources
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Integration Deployment
User preparation for integration setup and use

Procedure
Step 1

Gather requirements for your users, such as supported versions of software for the system, including user
workstations.
For more information, see the Release Notes for Cisco UC Integration for IBM Sametime.

Step 2

Provision users in Cisco Unified Communications Manager.
For information on how to set up users in Cisco Unified Communications Manager, see:
• Cisco Unified Communications Manager Administration Guide
• Cisco Unified Communications Manager System Guide

Step 3

Step 4

Provision users for computer-based phone features, such as Cisco Unified Communications Manager IM and
Presence Service.
Note
Cisco Unified Presence is no longer a standalone product, but is now a feature within Cisco Unified
Communications Manager. In UC 9.0, the Presence and IM feature has been integrated within Cisco
Unified Communications Manager and is referred to as “Cisco Unified Communications Manager
IM and Presence Service.”
While some customers might still be using Cisco Unified Presence, this document will refer to the
feature as “IM and Presence Service.”
Associate users with the Standard CTI- enabled user group in Cisco Unified Communications Manager.
This step is required if users use the Control Desk Phone feature. See existing dialing rules in Cisco Unified
Communications Manager Administration Guide.

Step 5
Step 6

Verify that application dial rules are set up in Cisco Unified Communications Manager.
Provision users in the IM and Presence Service.
This step is required for any user that enables the Enable Phone Status feature.

Step 7

Configure Cisco Unified Communications Manager Capability Assignments to enable licenses for the IM
and Presence Service.
For license requirements, see the Release Notes for Cisco UC Integration for IBM Sametime. For configuration
instructions, see Cisco Unified Communications Manager Administration Guide.

Step 8

Determine the server update site, the location from which Cisco UC Integration for IBM Sametime installs
on user workstations.
Set up a push update.
If you do not set up a push update for the standalone plug-in and the widget update for the embedded plug-in,
users manually install the plug-in on their client workstations. See the “Installation Methods” section for more
information.

Step 9

Step 10 Prepare users to install and use the plug-in.
Provide users with the Quick Start Guide for Cisco UC Integration for IBM Sametime.

User preparation for integration setup and use
When deciding which information and instructions to provide to users, consider the following factors:
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Integration Deployment
User preparation for integration setup and use

• Which integration features you enable
• Whether or not you set up the features to install automatically
• Which settings you preconfigure with the update site files
To install and configure the integration, ensure that your users have the following:
• Access to a supported version of IBM Sametime or IBM Lotus Notes and instructions for installation,
if needed
• Information about the features that are supported in your deployment
• Access to the Quick Start Guide for Cisco UC Integration for IBM Sametime for the following:
◦ The URL for the update site, if users must install the integration itself, and installation instructions
◦ Applicable values to use for system settings such as servers and configuration instructions
◦ Information about how to get support
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User preparation for integration setup and use
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Integration Site Setup Instructions
• Set up Local Directory, page 5
• File Uploads, page 5

Set up Local Directory
Procedure
Step 1
Step 2

Create a local working directory to hold the integration files that users will install on their workstations.
Navigate to the Cisco Unified Communications with IBM Sametime download page:
https://communities.cisco.com/community/technology/collaboration/usergroups/collaboration/cuciibmeap/
downloads
Then, sign in as a registered Cisco.com user.

Step 3
Step 4

Download the zip file that contains the integration files.
Extract the files from the zip file to the directory that you created in Step 1.
You can also order Cisco UC Integration for IBM Sametime from Cisco on CD.

What to Do Next
Go to “Configure Phone Control and Presence with the Configuration Tool.”

File Uploads
Use the following procedures to upload files to the update site. The files and folders that you copy to the
update site differ, depending on whether you are setting up a new site or modifying an existing one.
• Upload files to new site
• Upload files to existing site
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Integration Site Setup Instructions
Upload Files to New Site

Upload Files to New Site
Copy the entire UpdateSite directory from your local working CUCIIBM_RELEASE_9.0.X directory (where
X represents the current release number) to the web server that will host the update site.

Upload Files to Existing Site
Procedure
Step 1
Step 2
Step 3

Replace the site.xml file on the update site with a copy of the site.xm file from your local working
CUCIIBM_RELEASE_9.0.X/UpdateSite directory (where X represents the current release number).
Copy all files in your local working CUCIIBM_RELEASE_9.0.X/UpdateSite/features directory to the features
directory of the update site.
Copy all files in your local working CUCIIBM_RELEASE_9.0.X/UpdateSite/plugins directory to the plugins
directory of the update site.
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Integration Configuration
• Configure LDAP with the Configuration Tool, page 7
• Configure Voicemail Settings with the Configuration Tool, page 11
• Configure Phone Control and Presence with the Configuration Tool, page 12
• Credential Synchronization, page 16
• Phone Number Retrieval, page 17
• Enhanced LDAP Search Options, page 17
• Enable Live Text Support, page 17

Configure LDAP with the Configuration Tool
The default LDAP settings in this section represent common configurations. As an administrator, you must
determine if these settings are appropriate for your specific configuration and adjust them as necessary.
Using LDAP with Cisco Phone Control and Presence is optional. However, if you do not use LDAP, some
of the Phone Control and Presence functionality is diminished. Phone Control and Presence uses LDAP for
the following reasons:
• To resolve incoming callers as Sametime contacts. Sametime does not provide a way to look up a contact
using a phone number. Without LDAP, incoming calls display the caller number without a contact name,
because the number cannot be mapped to a Sametime contact without LDAP
• To retrieve additional phone numbers for Sametime contacts. Without LDAP, only the primary number
from the Business Card is used.
• To provide an additional way to map a Sametime contact to an IM and Presence Service user in order
to retrieve the phone status for that user. If this mapping can be achieved using an attribute from the
Business Card, then the phone status can be retrieved without using LDAP.
If you are using LDAP, Cisco Unified Communications Manager and the Sametime server should use the
same LDAP directory server, or the directory servers must use the same unique user ID to represent the same
user in each directory.
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Integration Configuration
Configure LDAP with the Configuration Tool

Note

LDAP settings are connected to other tabs in the Configuration Tool. If you make changes to the LDAP
settings and save the settings, you must also navigate to the Phone Control and Presence tab, and select
Save from the File menu before exiting.

Procedure
Step 1
Step 2
Step 3
Step 4

Download the Configuration Tool zip file and unzip the file to a local directory.
Navigate to the directory where you installed the Configuration Tool files and double-click ciscocfg.exe.
In the Choose an Update Site dialog box, enter the path of the Update Site directory that you created in the
section, "Set up local directory". Then, click OK.
Click the LDAP tab, if it is not already selected.

Step 5

Enter values in the applicable fields:
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Integration Configuration
Configure LDAP with the Configuration Tool

Field or Option Name

Description

Directory Server Settings The settings in this section define the directory and relevant attributes that the
plug-in can search to find usernames, based on incoming phone numbers.
Server

Enter the name or IP address of the LDAP server.

Port

Enter the number of the port that is used to communicate with the LDAP server.

Search Base

Enter the base (or root) of the directory service in which to search for names.
The value must match the one that was configured on the Sametime server. If
LDAP is used for the directory service, you can derive the setting directly from
there. If Domino is used instead, find the equivalent search base on its LDAP
interface.

Display Name Attribute

Enter the LDAP attribute that is used as the display name for the caller.

Attribute for Lookup in
Sametime

Enter the LDAP attribute that is used to search for the caller in Sametime.

Authentication
Credentials

Use the settings in this section to enter information that authenticates with the
directory server.

Authentication Required

Select this option if the server requires authentication. The following two fields
are active only if this option is selected.

Distinguished Name

Enter the distinguished name to authenticate with the directory service.

Password

Enter the password to authenticate with the directory service.

Directory Usage

Use this section to configure the use of non-default communities.

Cisco UC Integration for IBM Sametime Integration Guide
9
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Configure LDAP with the Configuration Tool

Field or Option Name

Description

Non-default Community
Access

Enable non-default communities to use directory services to extend the functions
to pilot communities, for example:
• Retrieve phone numbers to populate their contacts
• Show phone status for their contacts
You can use only one set of user data. You can have two communities, but they
must belong to the same global set of users. If the Sametime server for the
non-default communities uses the same LDAP server as the default community,
identical functionality can be extended to contacts in those communities.
Select the applicable setting:
• Disable—Select this option so that non-default communities cannot use
the directory service.
• Enable for All Communities—Select this option so that all non-default
communities are allowed to use the directory service.
• Enable for Configured Communities—Select this option so that only
communities that are listed in the Community List field are allowed to use
the directory service.

Community List

(When Non-default Community access is set to Enable for Configured
Communities) Enter the list of communities (Sametime hostname or IP address),
separated by commas, that you want to allow access to the directory service.

Directory Type for
Sametime Server

Choose one of the following options:
• LDAP: Select this option if the IBM Sametime server uses an LDAP server
for directory service.
If IBM Lotus Sametime uses an LDAP attribute for the internal user ID,
check the Use Attribute as Internal ID of Sametime User check box and
enter the name of the LDAP attribute.
• Domino: Select this option if the IBM Lotus Sametime server uses IBM
Lotus Domino for the directory service.
See the IBM Sametime documentation for information.

Step 6
Step 7

Step 8

From the File menu in the Configuration Tool window, select Save.
From the File menu in the Configuration Tool window, select Exit.
Note
Confirm that you have saved your changes in the Cisco Unified Communications with IBM Sametime
Configuration Tool window. Otherwise, all unsaved changes will be lost when you close the window.
For configuration changes to take effect, either set up IBM Sametime to automatically update users by using
a push update, or instruct users to update the plug-in from their IBM Sametime client.
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Integration Configuration
Configure Voicemail Settings with the Configuration Tool

What to Do Next
To configure the voicemail feature, go to “Configure Phone Control and Presence with the Configuration
Tool.”

Configure Voicemail Settings with the Configuration Tool
Procedure
Step 1
Step 2

Navigate to the ciscocfg directory of the extracted files.
Double-click ciscocfg.exe to start the Configuration Tool.

Step 3
Step 4

Click OK.
Click the Voicemail tab and enter the values in the applicable fields.

Field Name

Description

Feature Control

This section contains the option to enable or disable the voicemail feature
for your users.

Enable Voicemail

Check this check box to enable the voicemail feature for users.
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Configure Phone Control and Presence with the Configuration Tool

Field Name

Description

Mail Store Connection
Settings

Use the fields and options in this section to configure the voicemail server.

Server

For Cisco Unity Connection, enter the name or IP address of the Connection
server.

LDAP Attributes

Use the fields in this section to enter LDAP configuration information for
the voicemail feature.

User ID

Enter the LDAP user attribute that contains the user ID in voice messages
so that a directory search can find and display the username.

Phone Numbers

Enter the LDAP phone attributes that contain the caller ID in voice messages
so that a directory search can replace the phone number with the caller name
on voicemail.

Logging

Use the option in this section to activate logging.

Enable Detailed Logging

Check this check box to enable detailed logging.
Note

Step 5

Enable detailed logging only for troubleshooting. Otherwise, the
logging will affect system performance.

Select File > Save in the Configuration Tool window.

What to Do Next
Go to the next section, "Configure Phone Control and Presence with the Configuration Tool."

Configure Phone Control and Presence with the Configuration
Tool
The default Phone Control and Presence settings in this section represent common configurations. As an
administrator, you must determine if these settings are appropriate for your specific configuration and adjust
them as necessary.
Use the Configuration Tool to specify the update site files and to configure settings that apply to users of the
plug-in. You can use the tool for configuring new installations of the plug-in, and for updating user configuration
information after the plug-in is installed.
For configuration changes to take effect, you must either set up IBM Sametime to automatically update users
by using a push update, or instruct users to update the plug-in from their IBM Sametime Connect client.

Before You Begin
Understand that your saved field settings will overwrite corresponding user settings when the configuration
feature is installed on client workstations.
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Configure Phone Control and Presence with the Configuration Tool

Procedure
Step 1

Navigate to the ciscocfg directory and double-click ciscocfg.exe to start the Configuration Tool.

Step 2

Specify the location of the local working CiscoUCIntegrationWithST/UpdateSite directory in the Update Site
Selection window.
Select OK.
Select the Phone Control and Presence tab and enter the values in the applicable fields:

Step 3
Step 4
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Configure Phone Control and Presence with the Configuration Tool

Field or Option Name

Description

Feature Control

The options in this section enable and disable phone control features for users
and determine the default behavior of these features.

Enable Phone Status

Check this check box to enable the phone status feature for all users.

Enable Use My Computer for Check this check box to enable the Use My Computer for Calls phone mode
Calls
for all users.
Enable Use My Phone for
Calls

Check this check box to enable all users who have desk phones to control
their phones through IBM Sametime.

Default Phone Mode

Select Use My Computer for Calls or Use My Phone for Calls as the default
phone mode for all users. This setting applies only if you choose to enable
both phone modes.

Default Video Call

Select Always Start Calls with Video or Never Start Calls with Video as
the default video mode for all users.

Cisco Unified
Communications Manager

The fields and options in this section configure the integration with your
phone and presence servers.
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Configure Phone Control and Presence with the Configuration Tool

Field or Option Name

Description

CCMIP Server

Enter the name or IP address of the CCMIP server.

TFTP Server

Enter the name or IP address of the TFTP server.

CTI Server

Enter the name or IP address of the CTI server.

Synchronize Credentials

Check this check box to synchronize credentials. When you select this option,
you can choose:
• Use Sametime Credentials: Select this option if users have the same
user ID and password for the IM and Presence Service and Sametime
Connect, and you want to set these fields for all users.
• Use Synchronized Cisco UC Credentials: Select this option if you
want users to enter their IM and Presence Service server credentials
into Sametime Connect.

LDAP Phone Attributes

Use the fields in this section to configure LDAP attributes for Phone Control
and Presence.

Outgoing

Enter the LDAP phone attributes to populate for a Sametime contact. This
option allows a user to call phone numbers found in LDAP for the specified
LDAP attributes. For example: telephonenumber(Work), mobile(Mobile),
pager(Pager). Beside the attribute, the text in parentheses () is the label that
is displayed next to the phone number in the user interface (menu). for
example, the phone number that is retrieved from attribute "telephonenumber"
is displayed as Work (+1 408 902 3232).

Incoming

Enter the LDAP phone attributes to look up a contact. Typically, this option
is used to resolve an incoming phone number into a contact. For example:
telephonenumber, mobile

Phone Status Settings

Use this section to configure the phone presence feature.

IM and Presence Service
Servers

Enter the name or IP address of the IM and Presence Service server, if you
choose to enable phone status. You can enter multiple servers separated by
commas for failover purposes (match the IM and Presence Service server-side
settings for failover).

Sametime User ID Mapping

Choose one of the following options:
• Use LDAP Attribute: Select this option to use the LDAP attribute as
the User ID in the IM and Presence Service server. Choose this attribute
when the attribute is contained in the Sametime Internal user ID.
• Use Business Card Attribute: Select this option to use the Business
Card attribute as the user ID in the IM and Presence Service server.
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Credential Synchronization

Field or Option Name

Description

Phone Number Retrieval Uncheck this check box to disable preloading phones from LDAP. Disabling
Retrieve Phone Numbers for this option can cause a minor delay in LDAP search response when the user
Contacts at Startup
requests a listing of available phones.
Logging - Enable Detailed
Logging

Step 5
Step 6

Step 7

Check this check box to have user log files include more detailed information
by default. Note that detailed logging affects performance. For best
performance, enable detailed logging only in lab environments or when
debugging a specific issue.

On the File menu in the Configuration Tool window, select Save.
On the File menu in the Configuration Tool window, select Exit.
Note
Confirm that you have saved your changes in the Cisco Unified Communications with IBM Lotus
Sametime Configuration Tool window. Otherwise, all unsaved changes will be lost when you close
the window.
For configuration changes to take effect, either set up IBM Sametime to automatically update users by using
a push update, or instruct users to update the plug-in from their IBM Lotus client.

Credential Synchronization
Cisco UC Integration for IBM Sametime 9.0 provides credential synchronization across Cisco Unified
Communications services such as Cisco Unified Communications Manager, the IM and Presence Service,
and Cisco Unity Connection. Credential synchronization ensures that when credentials for one service are
changed, those same credentials will be automatically synchronized to other configured services.
The credentials that users enter to log in to Cisco UC Integration for IBM Sametime depend on how you
configure your system:
• If you synchronize user accounts with Sametime, then Cisco UC Integration for IBM Sametime
automatically logs the user in to their phone, phone status, and voicemail accounts with their Sametime
credentials.
• If you configure Cisco UC Integration for IBM Sametime to use synchronized Cisco UC credentials,
then users enter their Cisco UC credentials once and the integration uses these credentials to log users
in to their phone, phone status, and voicemail accounts.
• If you do not synchronize user accounts, then users must enter their credentials for each of their servers
individually.
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Configure synchronization for Phone Control and Presence

Configure synchronization for Phone Control and Presence
Procedure
Step 1
Step 2
Step 3

Start the Configuration Tool and click the Phone Control and Presence tab.
In the Cisco Unified Communications Manager area, check the Synchronize Credentials check box.
Choose one of the following options:
• Use Sametime Credentials
• Use Synchronized Cisco UC Credentials

Step 4

Save the new configuration.

Phone Number Retrieval
Cisco UC Integration for IBM Sametime can retrieve phone numbers in bulk from LDAP at startup or per
contact as needed. Configure this with the Retrieve Phone Numbers for Contacts at Startup check box in the
Phone Number Retrieval area. This check box is selected by default.
To reduce the load on the LDAP server at start-up time and disperse the load throughout the day, uncheck
this check box. This disables retrieval of all phone numbers in bulk from LDAP. Taking this action might
require a user to open the phone call menu twice before phone numbers for the contact are visible. This will
only occur once per contact, per login session.

Enhanced LDAP Search Options
If you leave the Incoming or Outgoing field blank in the LDAP Phone Attributes area on the Phone Control
and Presence tab of the Configuration Utility, this affects LDAP phone searches. The effects are as follows:
• If the Incoming field is left blank, no LDAP search is performed on incoming calls to resolve the phone
to a Sametime contact.
• If the Outgoing field is left blank, no LDAP search is performed to pre-load values or in real time when
the context menu is used.

Enable Live Text Support
Cisco UC Integration with IBM Lotus Sametime supports Click to Call from Live Text. Live Text must be
enabled with a policy that makes the feature available to users. Perform the following procedure to enable
Live Text:
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Integration Configuration
Enable Live Text Support

Procedure
Step 1
Step 2
Step 3
Step 4
Step 5
Step 6
Step 7
Step 8
Step 9
Step 10

Open the IBM Domino Administrator application.
Add the new policy.
Select the Basics tab.
Enter a name for the policy in the Policy name field.
In the Policy type field, select Organizational.
In the Desktop settings area, select the New button.
In the Enable Live Text field, select Enable.
Select Save and Close.
Save the new policy.
Apply the new policy.
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Troubleshooting
• Create Problem Report, page 19
• Enable Logging in the Configuration Utility, page 20
• Disable Extra IBM Call Option in Live Text Window, page 20
• Troubleshoot Phone Presence Issues, page 21

Create Problem Report
If unexpected or unresolvable issues occur, users can generate reports with detailed configuration and logging
information. These reports can assist Cisco TAC in troubleshooting.

Note

Enable detailed logging should not be checked in the Configuration Utility for a production deployment.
Detailed logging should be enabled only on a client as necessary, so that a user can generate the logs to
capture the issue and then turn logging off when log collection is complete.
Instruct the user to restart IBM Sametime or IBM Lotus Notes after they enable detailed logging, because
critical information, such as the configuration settings, is in the log files at startup.
When you troubleshoot issues with the plug-in, inspect the following log files for errors and warnings:
• IBM Sametime—trace-log-0.xml and error-log-0.xml
• IBM Lotus Notes—trace-log-0.xml and error-log-0.xml
To view the log location, choose File > Preferences and then Cisco > General.
To obtain a report:
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Enable Logging in the Configuration Utility

Procedure
Step 1
Step 2
Step 3

Enable detailed logging.
Reproduce the issue.
To create a problem report, choose Create Problem Report from the Help menu.

Enable Logging in the Configuration Utility
If you report an issue to Cisco Support, you should enable logging to provide valuable data to support engineers
as they diagnose the issue. You can enable logging for all users with the Configuration Utility. The detailed
logging feature allows you to capture logs separately for voicemail or for Phone Control and Presence:
• For voicemail logging, click the Voicemail tab and then check the Enable Detailed Logging check
box.
• For Phone Control and Presence logging, click the Phone Control and Presence tab and then check
the Enable Detailed Logging check box.

Note

Remember that the log files will continue to accumulate after you enable logging. Be certain to uncheck
the Enable Detailed Logging check box when you no longer require logs.

Disable Extra IBM Call Option in Live Text Window
The Live Text feature allows you to open a call menu when you click on a live text object (the user can
right-click to open a window or left-click on a drop-down arrow beside the live text to open a menu. Depending
on the IBM Sametime setup for your organization, the window or menu can display an extra Call option.
To disable the extra Call option, follow this procedure:

Procedure
Step 1

Contact IBM and obtain the hot fix binary MEWE-8UEB9U. Then install the hot fix.

Step 2

Configure the following managed settings to create a boolean flag. The flag, when set to true, forcefully
disables LiveText call actions:
• Setting: disableLiveTextCallAction
• Setting group name: com.ibm.collaboration.realtime.telephony.ui
• Setting type: Boolean
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Troubleshoot Phone Presence Issues

Note

If an extra phone icon appears on the Sametime button bar, disable TCSCPI or
SUT.
IBM Sametime version to 8.5.2 or later is required to fix the extra phone icon
issue.
See IBM documentation for more information.

Troubleshoot Phone Presence Issues
Prevent issues related to phone presence with one of the following methods:
• Create a file called managed-settings.xml in the root directory of your update site, which is the same
directory that contains your site.xml file. If you are not using auto-push to deploy the integration, you
only require the managed-settings.xml file in the root directory.
The following is an example of the managed-settings.xml file that is configured to enable phone status:
<?xml version="1.0" encoding="utf-8"?>
<ManagedSettings>
<settingGroup name="com.ibm.collaboration.realtime">
<setting name="enableSUT" value="false"/>
<setting name="enableTelephonyStatus" value="false"/>
<setting name="enableExtendedStatus" value="true"/>
</settingGroup>
</ManagedSettings>

Note

You must set the enableExtendedStatus value to true to enable Phone Control and
Presence to show phone status .

• Ensure that the Lotus Notes file, C:\Program Files
(x86)\IBM\Lotus\Notes\framework\rcp\plugin_customization.ini, includes the following lines:
com.ibm.notes.branding/enable.update.ui=true
com.ibm.collaboration.realtime/enableExtendedStatus=true

• Check that your IM and Presence Service credentials are correct. Also, check for the following error in
the details logs (for example, trace-log-0, trace-log-1, trace-log-2):
In PhoneStatusManager: Entering OnLoginError...
This error could include one of the following components:
Error Component

Meaning

ERR_CUP_UNREACHABLE

The IM and Presence Service is unreachable.

ERR_CUP_AUTH

The IM and Presence Service credentials are incorrect.

ERR_JABBER_UNREACHABLE

The IM and Presence Service is reachable, but it cannot
connect to Jabber services that are running on the CUP server.
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Troubleshooting
Troubleshoot Phone Presence Issues

• Assign the domain (the same one as was provided on the CUP server) value for the parameter Domain
Name in the Cisco UC Integration for IBM Sametime Administration Utility.
• Assign a unique value for the IM and Presence Service user ID for whatever LDAP attribute you use.
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